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RL78 Family CS+ 
Debugging Using Hot Plug-in Function 

 

Introduction 
This document describes the procedures of debugging using the hot plug-in function provided in some 

RL78 family microcontrollers such as RL78/Fxx (RL78/F12 MCU does not support hot plug-in function.). 

Tool settings and connection procedures when using CS+ for CA,CX, Renesas Flash Programmer, E1 
emulator, hot-plug adapter (R0E000010ACB00), and CPU board (QB-R5F10BMG-TB) are described in 
detail in the order of program creation -> building -> debugging steps. 

When using CS+ for CC, the hot plug-in method is same, so please refer to this document. But note that 
only the hot plug-in initialization function is different. 

 

Remarks 1: For operations of CS+, refer to the CS+ User's Manual. 
 2: For information regarding the circuit for connecting the E1 to the user system and regarding 

the user resources to be used, refer to " Emulator User's Manual" (document number: 
R20UT1994). 

 3: For operations of the Renesas Flash Programmer, refer to the Renesas Flash Programmer 
User's Manual. 

 
 

 

 

 

 

 

 

 
Figure 1   Overview of System 
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1. Overview of Debugging Using Hot Plug-in Function 

1.1 Features of Hot Plug-in Function 
The hot plug-in function allows the debugger to be connected during user system operation with "program 

execution continued", "no reset applied", and "program contents not modified". 
When a failure is found during inspection or after shipment of a user system, it can be debugged with the 

failure status retained through the hot plug-in function. 

The following shows the main features of the hot plug-in function. 

 

►Feature 1: The failure status can be retained. 
When the debugger is connected,  

• program execution can continue, 

• no reset is generated, and 

• program contents do not need to be modified. 

 

►Feature 2: The program is protected by the security function. 

• ID code authentication is done when the debugger is connected. 

 

►Feature 3: Failures can be analyzed while operation continues. 

• After the debugger is connected, RAM monitoring using the DTC is possible without stopping the 
CPU operation. 

 

►Feature 4: Detailed analysis is possible. 

• Forced break can be used. 

• After a break, software break or event break can be specified. 

 

Note: The hot plug-in function is aimed at failure analysis. Use the conventional on-chip debugging function 
in early stages of user program development. 
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1.2 Debugging after Hot Plug-in Connection 
After hot plug-in connection of the debugger to the microcontroller that is operating, debugging can be 

done with the CPU operation continued through the RRM or DMM using the DTC dedicated to debugging. 
The conventional RL78 microcontrollers use the CPU to access memory for debugging, but integrating the 

debug DTC on the chip enables memory access for debugging without using the CPU. 

The following areas can be accessed through RRM/DMM using the DTC. 

[Readable/writable resources] 

• RAM 

• SFRs 

[Read-only resources] 

• Data flash (only when reading is enabled) 

• Mirror area 

• General registers 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 2  Concept of Debug DTC  
 

[Description of terms] 

• DTC: Data transfer controller. This transfers data between memory units without CPU intervention. 

• RRM: Realtime RAM monitor. This reads data from RAM or SFRs without stopping CPU operation. 

• DMM: Dynamic memory modification. This writes to RAM or SFRs without stopping CPU operation.
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2. Debugging Procedures Using Hot Plug-in Function 
This section describes the procedures for debugging using the hot plug-in function. 

 

2.1 Overview of Operation Procedures 
 

The following shows the operation procedures. 
Install the CS+ before starting the procedures. 
 
 

1. Creating a program 
 To use the hot plug-in function, the hot plug-in initialization function should be 

executed in the user program. 
 A later section describes how to create a user program including the hot plug-in 

initialization function. 

 

 

 
2. Building 

 To use the hot plug-in function, user RAM should be allocated and the on-chip 
debugging option byte should be set up. A later section describes how to make these 
settings through build options. 

 

 

 
3. Writing and executing the program 

Write the hex file through the Renesas Flash Programmer and execute it on the 
user system. 

 

 

 

4. Connecting through hot plug-in function 
Execute the hot plug-in function through the E1 emulator.  

 

 

 
5. Debugging 

How to use the debugging functions while the debugger is connected through the 
hot plug-in function is described in a later section. 
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2.2 Actual Operations Using Hot Plug-in Function 
 

2.2.1 Creating a Program that Allows Hot Plug-in Connection 
 

(1) Starting CS+ 

Select [Start] → [Programs] → [Renesas Electronics CS+] → [CS+ for CA,CX] to start CS+.  
 

(2) Creating a Project 

• Create a new project from the start panel.  
     
 
 
 
 
 
 
 
 
 
 
 
 
1. Start creation Click the [GO] button under "Create New Project".  

 
  • Make detailed settings for the project. 

   

 
 
 
 
 

 

 
 

 

 
 

1. Specify [Using microcontroller] Select the name of the device to be used. In 
this example, "R5F10PMF(80pin)" is selected.  

2. Specify [Project name] A desired name can be specified. In this 
example, "sample" is specified.  

3. Specify [Place] A desired place can be specified. In this 
example, "C:¥" is specified. 

4. Create a project Click the [Create] button.  

1. 

2. 

3. 

4. 

1. 
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(3) Creating a User Program 

• Create the main.c file.  

 
 
 
 
 
 
 
 
 

 
1. Open the context menu for 

"File" 
Select "File" in the project tree and then right-click it. 

2. Add a new file Select [Add] → [Add New File].  
3. Specify [File name] A desired name can be specified. In this example, 

"main.c" is specified. 
4. Specify [File location] A desired location can be specified. In this example, 

"C:¥sample¥" is specified. 
5. Create a file Click the [OK] button.  

 
• Edit the main.c file.  

 
 
 
 
 
 
 
 
 
 
 

 
1. Open "main.c" Double-click "main.c" in the project tree.  
2. Edit the main function Copy and paste the following to the main.c file. 
int g_i=0; 
int g_j=0; 
int g_k=0; 
 
void main() { 
 while(1) { 
  g_i++; 
  g_j++; 
  g_k++; 
 } 
} 

 

1. 

2. 

1. 2. 

3. 

5. 

4. 
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(4) Creating the Hot Plug-in Initialization Function 

• Create a file for defining the hot plug-in initialization function (hpi_initialize_prog).  

  Add the hpi_init.asm file to the project. 

 
 
 
 
 
 
 
 
 

 
1. Open the context menu for 

"File" 
Select "File" in the project tree and then right-click it. 

2. Add a new file Select [Add] → [Add New File].  
3. Specify [File name] A desired name can be specified. In this example, 

"hpi_init.asm" is specified. 
4. Specify [File location] A desired location can be specified. In this example, 

"C:¥sample¥" is specified. 
5. Create a file Click the [OK] button.  

 
    • Edit the hot plug-in initialization function (hpi_initialize_prog).  

 
 
 
 
 
 
 
 
 
 
 
 

 
1. Open "hpi_init.asm" Double-click "hpi_init.asm" in the project tree.  
2. Edit the hot plug-in initialization 

function 
Copy and paste the contents on the next page to the 
hpi_init.asm file. 

 

1. 
2. 

1. 2. 

3. 

5. 

4. 
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Note: The following shows the hot plug-in initialization function, which initializes and enables the DTC 

dedicated to debugging. Copy this function to the user program without change.  

[How to Use Initialization Function] 
• Call the function with the earliest possible timing after RAM initialization is completed. 

Execution of the initialization function should be completed within 400 ms after the CPU reset is 

canceled. If execution is not completed within this period, the debugger will hang when a pin reset 
or a POC reset occurs after hot plug-in connection. 

• Call this function only once after a reset. 

• As SFRs are manipulated in the initialization function, disable the SFR guard function before calling 
this function.  

• In this initialization function, interrupts are disabled until the execution of the function is completed. 

When interrupts need to be enabled, delete three lines including "for disable interrupt" as comments. 
(When interrupts are enabled, take care of the time until the execution of the initialization function is 

completed and the stack size to be used.) 

 
CS+ for CA,CX (RL78/F1x) 

 
  PUBLIC _hpi_initialize_prog 
 
_hpi_initialize_prog: 
 PUSH PSW ;for disable interrupt 
 DI  ;for disable interrupt 
 PUSH AX 
 PUSH DE 
 PUSH HL 
 MOV A,ES 
 PUSH AX 
 
 MOV ES,#000H 
 MOVW DE,#000C4H 
 MOVW HL, #00722H 
 BT [HL].7,$SET_TRCSIZE1 
SET_TRCSIZE0: 
 MOVW HL,#00D00H 
 BR $SEC_CODE_SET 
SET_TRCSIZE1: 
 MOVW HL,#00E00H 
SEC_CHK: 
 MOV A,!0723H 
 BT A.0, $DTC_DES_SET 
 
SEC_CODE_SET: 
 MOV A,ES:[DE] 
 MOV [HL],A 
 INCW DE 
 INCW HL 
 MOVW AX,DE 
 CMPW AX,#000CEH 
 SKZ 
 BR $SEC_CODE_SET 
DTC_DES_SET: 
 MOV ES,#00FH 
 MOV L,#00EH 
 MOVW AX,#0FFADH 
 MOVW [HL],AX 
 MOV L,#010H 
DTC_SET: 
 MOV [HL+00H],#013H 
 MOV [HL+01H],#001H 
 MOV [HL+02H],#00AH 
 MOV [HL+03H],#00AH 
 MOV [HL+04H],#000H 
 MOV A,H 
 MOV [HL+05H],A 
 MOV [HL+06H],#023H 
 MOV [HL+07H],#007H 
 MOV [HL+08H],#000H 
 MOV [HL+09H],#001H 
 MOV [HL+0AH],#001H 
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 MOV [HL+0BH],#001H 
 MOV [HL+0CH],#023H 
 MOV [HL+0DH],#007H 
 MOV [HL+0EH],#0ADH 
 MOV [HL+0FH],#0FFH 
 MOV [HL+10H],#011H 
 MOV [HL+11H],#001H 
 MOV [HL+12H],#010H 
 MOV [HL+13H],#010H 
 MOV [HL+14H],#0ADH 
 MOV [HL+15H],#0FFH 
 MOV [HL+16H],#000H 
 MOV A,H 
 MOV [HL+17H],A 
 MOV [HL+18H],#003H 
 MOV [HL+19H],#001H 
 MOV [HL+1AH],#010H 
 MOV [HL+1BH],#010H 
 MOV [HL+1CH],#000H 
 MOV A,H 
 MOV [HL+1DH],A 
 MOV [HL+1EH],#0ADH 
 MOV [HL+1FH],#0FFH 
 SET1 DTCEN 
 
 POP AX 
 MOV ES,A 
 POP HL 
 POP DE 
 POP AX 
 POP PSW ;for disable interrupt 
 
 RET 
 END 

 

CS+ for CC (RL78/F1x) 
 
.PUBLIC _hpi_initialize_prog 
 
_hpi_initialize_prog: 
 PUSH PSW  ;for disable interrupt 
 DI   ;for disable interrupt 
 PUSH AX 
 PUSH DE 
 PUSH HL 
 MOV A,ES 
 PUSH AX 
 MOV ES,#0x000 
 MOVW DE,#0x000C4 
 MOVW HL, #0x00722 
 BT [HL].7,$SET_TRCSIZE1 
 SET_TRCSIZE0: 
 MOVW HL,#0x00D00 
 BR $SEC_CODE_SET 
SET_TRCSIZE1: 
 MOVW HL,#0x00E00 
SEC_CHK: 
 MOV A,!0x0723 
 BT A.0, $DTC_DES_SET 
SEC_CODE_SET: 
 MOV A,ES:[DE] 
 MOV [HL],A 
 INCW DE 
 INCW HL 
 MOVW AX,DE 
 CMPW AX,#0x000CE 
 SKZ 
 BR $SEC_CODE_SET 
DTC_DES_SET: 
 MOV ES,#0x00F 
 MOV L,#0x00E 
 MOVW AX,#0x0FFAD 
 MOVW [HL],AX 
 MOV L,#0x010 
DTC_SET: 
 MOV [HL+0x00],#0x013 
 MOV [HL+0x01],#0x001 
 MOV [HL+0x02],#0x00A 
 MOV [HL+0x03],#0x00A 
 MOV [HL+0x04],#0x000 
 MOV A,H 
 MOV [HL+0x05],A 
 MOV [HL+0x06],#0x023 
 MOV [HL+0x07],#0x007 
 MOV [HL+0x08],#0x000 
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 MOV [HL+0x09],#0x001 
 MOV [HL+0x0A],#0x001 
 MOV [HL+0x0B],#0x001 
 MOV [HL+0x0C],#0x023 
 MOV [HL+0x0D],#0x007 
 MOV [HL+0x0E],#0x0AD 
 MOV [HL+0x0F],#0x0FF 
 MOV [HL+0x10],#0x011 
 MOV [HL+0x11],#0x001 
 MOV [HL+0x12],#0x010 
 MOV [HL+0x13],#0x010 
 MOV [HL+0x14],#0x0AD 
 MOV [HL+0x15],#0x0FF 
 MOV [HL+0x16],#0x000 
 MOV A,H 
 MOV [HL+0x17],A 
 MOV [HL+0x18],#0x003 
 MOV [HL+0x19],#0x001 
 MOV [HL+0x1A],#0x010 
 MOV [HL+0x1B],#0x010 
 MOV [HL+0x1C],#0x000 
 MOV A,H 
 MOV [HL+0x1D],A 
 MOV [HL+0x1E],#0x0AD 
 MOV [HL+0x1F],#0x0FF 
 SET1 !DTCEN 
 POP AX 
 MOV ES,A 
 POP HL 
 POP DE 
 POP AX 
 POP PSW  ;for disable interrupt 
 RET 
 

 

CS+ for CC (RL78/F2x) 
 
.PUBLIC _hpi_initialize_prog_f2x 
 
_hpi_initialize_prog_f2x: 
 PUSH PSW  ;for disable interrupt 
 DI   ;for disable interrupt 
 PUSH AX 
 PUSH DE 
 PUSH HL 
 MOV A,ES 
 PUSH AX 
 MOV ES,#0x000 
 MOVW DE,#0x000C4 
 MOV A,ES:[DE] 
 BT A.2,$GO_SETHPI 
 BR $!NOHPISET_RETURN 
GO_SETHPI: 
 MOVW DE,#0x000C6 
 MOVW HL, #0x00722 
 BT [HL].7,$SET_TRCSIZE1 
SET_TRCSIZE0: 
 MOVW HL,#0x00D00 
 BR $SEC_CHK 
SET_TRCSIZE1: 
 MOVW HL,#0x00E00 
SEC_CHK: 
 MOV A,!0x0723 
 BT A.0, $DTC_DES_SET 
SEC_CODE_SET: 
 MOV A,ES:[DE] 
 MOV [HL],A 
 INCW DE 
 INCW HL 
 MOVW AX,DE 
 CMPW AX,#0x000D6 
 SKZ 
 BR $SEC_CODE_SET 
 BR $DTC_SET_SUB 
DTC_DES_SET: 
 MOV ES,#0x00F 
 MOV L,#0x00E 
 MOVW AX,#0x0FFAD 
 MOVW [HL],AX 
DTC_SET_SUB: 
 MOV L,#0x010 
DTC_SET: 
 MOV [HL+0x00],#0x013 
 MOV [HL+0x01],#0x001 
 MOV [HL+0x02],#0x010 
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 MOV [HL+0x03],#0x010 
 MOV [HL+0x04],#0x000 
 MOV A,H 
 MOV [HL+0x05],A 
 MOV [HL+0x06],#0x023 
 MOV [HL+0x07],#0x007 
 MOV [HL+0x08],#0x000 
 MOV [HL+0x09],#0x001 
 MOV [HL+0x0A],#0x001 
 MOV [HL+0x0B],#0x001 
 MOV [HL+0x0C],#0x023 
 MOV [HL+0x0D],#0x007 
 MOV [HL+0x0E],#0x0AD 
 MOV [HL+0x0F],#0x0FF 
 MOV [HL+0x10],#0x011 
 MOV [HL+0x11],#0x001 
 MOV [HL+0x12],#0x010 
 MOV [HL+0x13],#0x010 
 MOV [HL+0x14],#0x0AD 
 MOV [HL+0x15],#0x0FF 
 MOV [HL+0x16],#0x000 
 MOV A,H 
 MOV [HL+0x17],A 
 MOV [HL+0x18],#0x003 
 MOV [HL+0x19],#0x001 
 MOV [HL+0x1A],#0x010 
 MOV [HL+0x1B],#0x010 
 MOV [HL+0x1C],#0x000 
 MOV A,H 
 MOV [HL+0x1D],A 
 MOV [HL+0x1E],#0x0AD 
 MOV [HL+0x1F],#0x0FF 
 SET1 !DTCEN 
NOHPISET_RETURN: 
 POP AX 
 MOV ES,A 
 POP HL 
 POP DE 
 POP AX 
 POP PSW  ;for disable interrupt 
 RET 
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• Add the lines for calling the hot plug-in initialization function (hpi_initialize_prog) to the main function.  

 
 
 
 
 
 
 
 

 
1. Open "main.c" Double-click "main.c" in the project tree. 
2. Write the hot plug-in 

initialization function 
Add the following to the main.c file. 

 
void hpi_initialize_prog(void); 
 
int g_i=0; 
int g_j=0; 
int g_k=0; 
 
void main() { 
 
 hpi_initialize_prog();  
 while(1) { 
  g_i++; 
  g_j++; 
  g_k++; 
 } 
} 

 

Add this line. 

Add this line. 

1. 2. 2. 
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2.2.2 Executing Build Process 

 

(1) Specifying the Security ID 

• Specify the security ID.  

Use the [Common Options] tab in the property panel for the build tool. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
1. Open the context menu for "CA78K0R (Build 

Tool)" 
Select "CA78K0R (Build Tool)" in the project tree and 
then right-click it. 

2. Open the property panel Select [Property] from the context menu.  
3. Open the [Common Options] tab Select the [Common Options] tab in the main panel. 
4. Specify [Security ID] Specify [Security ID] under "Device". A desired ID can 

be specified. In this example, 
"00000000000000000000" is specified.  

 

 

1. 

2. 

3. 

4. 



RL78 Family CS+  Debugging Using Hot Plug-in Function  

R20AN0248EJ0400  Rev.4.00  Page 15 of 29 
Dec. 20, 2023  

 

(2) Specifying the Option Bytes 

• Specify the option byte for on-chip debugging. 

  Use the "Link Options" tab in the property panel for the build tool.  

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
1. Open the context menu for "CA78K0R (Build 

Tool)" 
Select "CA78K0R (Build Tool)" in the project tree 
and then right-click it. 

2. Open the property panel Select "Property" from the context menu.  
3. Open the [Link Options] tab Select the [Link Options] tab in the main panel. 
4. Expand "Device" Expand "Device". 
5. [Set enable/disable on-chip debug by link option] Select "Yes".  

6. [Option bye values for OCD] Specify "87".  
7. [Debug monitor area size] Specify "0".  

Note: Specify an appropriate size when normal 
on-chip debugging is done without using the 
hot plug-in function.  

[Option Byte Setting for On-chip Debugging] 
When using the hot plug-in function, be sure to set the option byte for on-chip debugging to 0x87. The hot 

plug-in is detected using the low-speed on-chip oscillator. When the above value is specified, the 

low-speed on-chip oscillator operates and cannot be stopped from the user program. However, only in 
standby mode, it can be stopped through register settings.  

1. 

2. 

3. 

5. 

7. 

6. 

4. 
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• Specify the user option byte. 

  Use the [Link Options] tab in the property panel for the build tool.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
1. [Set user option byte] Select "Yes".  
2. [User option byte value] A desired value can be specified. In this 

example, "60FFE8" is specified. 
 

(3) Allocating RAM for Hot Plug-in 

• Use the [Link Options] tab in the property panel for the build tool to prohibit the user program from using 
the RAM area that is to be used for hot plug-in. 
Note: For the product types that do not need RAM allocation to the hot plug-in function, the following 

item will not appear in the CS+ display. Skip this setting and move to the next step.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
1. [Control allocation to hot plug-in 

RAM area] 
Select "Yes(Error message)".  

1. 

1. 
2. 
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(4) Executing the Build Process 

• Settings of edit and build tool options have been completed. Execute the build process. 
 
 
 

 
1. Execute rebuild process Click the [Rebuild] menu button.  

1. 
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2.2.3 Writing and Executing Program 
 
(1) Writing a Program 

• Write the created hex file to the target device through the Renesas Flash Programmer.  

For usage of the Renesas Flash Programmer, refer to the user's manual that can be found by 
selecting [Start] → [Programs] → [Renesas Electronics Utilities] → [Programming Tools] → [Renesas 

Flash Programmer Vx.xx].  

 

 

 

 

 

 

 
(2) Executing the Program 

• Supply power to the user system and execute the program on the actual device. 

 

Host PC 
(Renesas Flash Programmer) E1 emulator 

User system 

Power 
supply 

User system 

+ 
- 
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2.2.4 Hot Plug-in Connection 
 
(1) Connecting the Hot-Plug Adapter (R0E000010ACB00) to the User System 

• Be sure to connect the R0E000010ACB0 to the user system first. 
  The R0E000010ACB00 has a mechanism that ensures that connection to the E1 emulator begins 

with the GND line.  

 
 

 

 
 

 

 
 

(2) Connecting the E1 Emulator to the Host PC 

• Connect the E1 to the host PC.  

 
 
 
 
 
 
 
(3) Making Debugging Function Settings 

• Select a debug tool in CS+.  

 
 
 
 
 
 
 

 
1. Open the context menu for 

"Debug Tool" 
Select "Debug Tool" in the project tree and then 
right-click it. 

2. Select a debug tool Select [Using Debug Tool] → [RL78 E1(Serial)].  
 

Host PC 
(CS+) 

E1 emulator 

1. 
2. 

R0E000010ACB00 
(Hot-plug adapter for E1 emulator) 

Power 
supply 

User system 

+ 
- 
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• Specify the security ID for authentication of E1 emulator connection. In addition, specify retry settings for 
the hot plug-in function.  

 
 
 
 
 
 
 
 

 

 

 
1. Open the property panel for 

"Debug Tool" 
Select "Debug Tool" in the project tree and then 
right-click it.  

2. Enter the security ID for 
authentication. 
 

Specify [Security ID] under "Flash" in the [Connect 
Settings] tab.  
Enter the same value as that specified as a common 
option for the build tool. In this example, enter 
"00000000000000000000". 

3. Make retry settings for hot 
plug-in 
 

Hot plug-in connection may fail when the low-speed 
on-chip oscillator stops due to, for example, the CPU 
being in the STOP mode. For such a case, specify the 
interval and number of hot plug-in retries.  
Since the program in this example does not stop the 
low-speed on-chip oscillator, these settings are left as 
the default values (1000 ms and three times). 

 

[Retry Settings for Hot Plug-in] 
• For the retrying interval, enter the longest period for which the STOP mode continues in the program.  
 Note that the debugger cannot be operated during the retry processing (retrying interval × number of 

retries).  
 Therefore, be careful not to make the retry processing period extremely long. 

1. 
1. 

2. 

2. 

3. 
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• Specify the RAM monitoring interval.  

 
 
 
 
 
 
 
 

 
1. Open the context menu for 

"Debug Tool" 
Select "Debug Tool" in the project tree and then 
right-click it.  

2. Open the property panel Select [Property].  
3. Specify [Display update 

interval] 
Specify [Display update interval] under "Access Memory 
While Running" in the [Debug Tool Settings] tab.  
A value of 100 ms or greater can be specified. 
In this example, "500" is specified.  

 
(4) Executing Hot Plug-in Connection 

• Prepare for hot plug-in connection.  

 
 
 
 
 
 
 
 
 
 

 
1. Shift the debugger to the hot 

plug-in preparation state 
Select [Hot Plug-in] from the [Debug] menu. 

 

• Check that the following dialog appears. 

 

 

1. 
2. 

3. 3. 

3. 1. 
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• Connecting the E1 emulator to the hot-plug adapter (R0E000010ACB00) 

Connect the E1 to the R0E000010ACB00. Connect the E1 emulator and hot-plug adapter while the 
connectors are correctly aligned on both sides.  

 

 

 

 
 

 

 

 

• Hot plug-in connection 

  After connecting the emulator, click the [OK] button on the following box.  

 
 
 
 
 
 

 
 

1. Hot plug-in connection Click the [OK] button.  
 

[Unavailable Functions after Hot Plug-in Connection] 
The following functions cannot be used after hot plug-in connection. To enable them, execute a forced 
break after hot plug-in connection.  

• Trace function 

• Input signal masking function 

• Event break function/sequential break function 

• Software break function 

• Settings regarding whether to operate or stop emulation of peripheral timer and serial modules while 
execution is stopped

1. 

Host PC 
(CS+) 

Connect 

+ Power 
supply - 

E1 emulator 

R0E000010ACB00 
(Hot-plug adapter for E1 emulator) 

User system 
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2.2.5 Debugging 
 

(1) Memory Display Update Function 

• Open the memory panel.  

 
 
 
 
 
 
 
 
 

 
1. Open the memory panel Open the [View] menu and select [Memory] → [Memory 

1].  
2. Check the memory panel 

where the RAM monitor function 
works 

The values on the memory panel are displayed in pink 
and the display is updated periodically.  

 

(2) Displaying Global Variables 

• Register a variable from the source.  

 
 
 
 
 
 
 
 
 

 
1. Register a global variable in the 

watch panel 
Drag and select "g_i" in the main.c source and 
right-click it. Then, select [Register to Watch1". 

2. Check the variable registered in the 
watch panel 

The value of the variable is updated periodically. 

 
 

 

 

 

1. 2. 

1. 2. 
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(3) Forced Break 

• Break execution of the program.  

 
 

 
1. Forced break of the program Click the "Stop" button on the menu bar. 

 
(4) Debugging Functions after Break 

• Software break 

  During program execution, a break occurs where a breakpoint is specified. 

 
 
 
 
 
 
 

 

 
1. Specify a software break Click the break setting column for the "g_j++;" line on 

the main.c source display.  
2. Check occurrence of the 

software break 
Execute the program and check that the specified 
software break occurs. 

 
 

1. 2. 

1. 
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• Access break 

  This function generates a break when a specified value is written to, read from, or written to/read from a 
variable. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

1. Open the context menu Drag and select "g_i" on the main.c source and 
right-click it.  

2. Specify an access break Select [Break Settings] → [Set Write Combination Break 
to] and specify the value that generates a break. A 
desired value can be specified. In this example, specify 
"0x01".  

3. Check occurrence of the 
access break 

When an access break occurs, execution of the program 
will stop and the accessed address and value will be 
displayed. 

 
 
 

 

 

 

1. 

2. 

3. 

3. 
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2.2.6 Disconnecting from User System 
 

(1) Disconnecting the Debug Tool 

  Disconnect the debug tool.  

  Notes: 1. Before disconnection, stop program execution.  

   2. When the debug tool is disconnected, a reset is applied to the microcontroller. After 
disconnection, the reset state continues as long as the emulator is connected. 

 3. To use the hot plug-in function again after disconnection, disconnect the E1 from the user 
system, reset the microcontroller, and then execute hot plug-in connection.  

 
 

 

 
1. Disconnect the debug tool Break execution of the program and click the 

[Disconnect] button on the menu bar. 

 
(2) Turning off the User System 

• Power off the user system.  

 

(3) Disconnecting the E1 Emulator 

• Disconnect the USB cable from the E1 emulator and the host PC.  

• Then, disconnect the E1 emulator from the user system.  

 

(4) Terminating the CS+ 

• Terminate CS+.  

 

 
 

1. 
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3. Notes 

3.1 Note on Debug DTC Operating Clock 
Supply of the clock for operating the debug DTC is specified through the DTCEN bit in the same way as 

the clock for the normal DTC. Therefore, do not clear the DTCEN bit to 0 before using the hot plug-in 
function or RRM/DMM using the DTC.  

 

3.2 Note on DTC Suspending Instructions 
Since the hot plug-in function and RRM/DMM using the DTC are implemented by using the DTC, when 

multiple DTC suspending instructions continue, start of the DTC is suspended. If the start of the DTC 
continues to be suspended, hot plug-in connection or RRM/DMM will fail.  

[DTC suspending instructions] 
 a) Unconditional branch instructions b) Call/return instructions 
 c) Conditional branch instructions d) Instructions for read access to the code flash area 
 e) Bit manipulation instructions for IFxx, MKxx, PRxx, and PSW and 8-bit manipulation instructions 

including the ES register as an operand 
Especially when an infinite loop processing is specified in the C language, note that the code is expanded 

to the assembly language as follows.  
 

 

 
In this case, modify the code so that DTC suspending instructions do not continue; for example, insert a 

NOP instruction in the infinite loop as follows.  

 

 
 

 

3.3 Note on Data Access Event 
When RRM/DMM using the DTC is used, if a data access event is specified for a target variable of 

RRM/DMM or for an SFR, the following events will occur at RRM/DMM access.  
• Event break (including sequential break) 
• Trace start/stop event 
When a data access event is specified for a variable or an SFR, do not use RRM/DMM using the DTC for 

that variable or SFR.  
 

3.4 Note on Access to a 32-Bit or Longer Variable 
The maximum data size in the DTC used in RRM/DMM using the DTC is 16 bits. 
Therefore, when reading from or writing to a 32-bit or longer variable conflicts with writing to the variable by 

the CPU, the read or written value may be wrong.  
For example, when a 32-bit variable is read, if the CPU writes to the variable between the upper 16-bit 

reading and lower 16-bit reading, the data before and after writing are read as the upper 16 bits and the 
lower 16 bits, respectively.  

void main (void){ 
while(1){} 

} 

void main (void){ 
while(1){ 

NOP()
; 
} 

} 

_main: 
 nop 

br main 

_main: 
br main 
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3.5 Notes on Standby Mode 
Pay attention to the following notes on standby mode.  
• Before hot plug-in connection 

When the MCU enters the standby mode before connection and either the low-speed on-chip oscillator 
or DTC operating clock stops, hot plug-in connection is disabled.  
When hot plug-in connection is disabled due to standby mode, use the retry settings.  

• After hot plug-in connection 
When the MCU enters the STOP mode after hot plug-in connection and the source of the DTC operating 
clock is not the high-speed on-chip oscillator, RRM/DMM using the DTC is suspended while the MCU is 
in the STOP mode. (RRM/DMM using the DTC is resumed when the STOP mode is canceled.) 
Note that the debugger uses the time specified for [Retrying interval] in the retry settings as the 
maximum period for suspension of RRM/DMM using the DTC. (If the STOP mode continues for the 
retrying interval, an error will occur.) 

 

3.6 Notes on Reset 
Pay attention to the following notes on reset.  
• Reset by the POR circuit while program execution is stopped 

After hot plug-in connection, if a reset is applied by the POR circuit while program execution is stopped, 
the user program runs for about 900 ms after the reset occurs and then stops.  

  * This is because the user program can be stopped only after execution of the hot plug-in initialization 
program is completed.  

• Reset by the POR circuit or pin reset during program execution  
After hot plug-in connection, if a reset by the POR circuit or a pin reset occurs during program execution, 
the following settings become disabled.  
- Hardware break settings (events are disabled) 

  - Trace function (events are disabled and tracing is stopped) 
  - Masking of input signals (all mask settings are disabled) 

When software break is used, if a reset by the POR circuit or a pin reset occurs and the instruction 
where a software breakpoint is set is executed before hot plug-in connection is done again, a reset due 
to execution of the 0xFF code will occur. 
Note that even after hot plug-in connection, the pin reset masking function can be used after a forced 
break is done. Therefore, if the above-described behavior is a problem, use the pin reset masking 
function instead. 

• Internal reset during program execution (except for the reset by the POR circuit and pin reset) 
After hot plug-in connection, if an internal reset occurs during program execution, RRM/DMM using the 
DTC will stop. After the time specified as the retrying interval has passed, RRM/DMM using the DTC will 
resume. 

 

3.7 Note on RAM Usage 
In some device types, an appropriate RAM area should be allocated to use the hot plug-in connection, 

RRM/DMM using the DTC, or trace function. For details, refer to the hardware manual(On-chip Trace) for 
each MCU. 
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https://www.renesas.com 
 
Inquiries 
   https://www.renesas.com/us/en/contact-us 
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General Precautions in the Handling of Microprocessing Unit and Microcontroller 
Unit Products 

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the products covered 
by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products. 

1. Precaution against Electrostatic Discharge (ESD) 

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps must be taken to 

stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be adequate. When it is dry, a 

humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity. Semiconductor devices must be stored and 

transported in an anti-static container, static shielding bag or conductive material. All test and measurement tools including work benches and floors must be grounded. 

The operator must also be grounded using a wrist strap. Semiconductor devices must not be touched with bare hands. Similar precautions must be taken for printed 

circuit boards with mounted semiconductor devices. 
2. Processing at power-on 

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of register settings 

and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset pin, the states of pins are not 

guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins in a product that is reset by an on-chip 

power-on reset function are not guaranteed from the time when power is supplied until the power reaches the level at which resetting is specified. 
3. Input of signal during power-off state 

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O pull-up power 

supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal elements. Follow the guideline for 

input signal during power-off state as described in your product documentation. 
4. Handling of unused pins 

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are generally in the 

high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of the LSI, an associated 

shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal become possible. 
5. Clock signals 

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program execution, wait 

until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator during a reset, ensure that the 

reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal produced with an external resonator or by an 

external oscillator while program execution is in progress, wait until the target clock signal is stable. 
6. Voltage application waveform at input pin 

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between VIL (Max.) and VIH 

(Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the input level is fixed, and also in 

the transition period when the input level passes through the area between VIL (Max.) and VIH (Min.). 
7. Prohibition of access to reserved addresses 

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these addresses as the 

correct operation of the LSI is not guaranteed. 
8. Differences between products 

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. The 

characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms of internal 

memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, operating margins, immunity 

to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-evaluation test for the given product. 
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